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Dear Theresa, 

I'd Love To Hear From YOU!  

Is there an article you would like to comment on? Is 
there a topic you want me to research? Have a funny 
story or a resource you want to share with the other 
subscribers? Then write to me! We are always looking 
for new and useful content to add to our newsletter.  

Since most of our customers are referrals, we would 
appreciate you forwarding this newsletter to friends or 
co-workers that you feel could benefit from our 
services. Just click on the "forward" button at the 
bottom and send it with a quick note.  

PC MedEvac will be closed on 10 October 2005 which is Columbus Day!  

PC MedEvac  
139 East Chatham 
Downtown Cary 
919.369.7800 
service@pcmedevac.com  
www.pcmedevac. com  

 
Matt Carter 

Hurricane Katrina Is A Grim Reminder  

     You hear it all the time from us—back up your data, keep your virus protection 
current, and install and maintain a firewall to protect yourself from hackers and other 
online threats.  

     However, with the recent and horrible devastations that hurricane Katrina created 
for businesses and home owners alike, you can see that anti-virus software isn’t 
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enough to protect your technology investments or your company’s critical data and 
records; that is why natural disasters also need to be taken into consideration when 
writing your company’s disaster recovery plan.  

Do You Have A Disaster Recovery Plan?  

     We all know that an ounce of prevention is worth a pound of cure; yet, disaster 
recovery planning often takes a distant second to the daily deadlines and pressures of 
running a business. According to a recent survey commissioned by AT&T, about one-
third of 1,200 respondents said they have no business continuity plan in place. Of 
those who do, nearly a quarter of the companies surveyed said they hadn’t updated 
their plans in the past 12 months, and nearly as many hadn’t tested them during that 
time either.  

     That means that most businesses, including your own, may be completely 
vulnerable to even a bad lightening storm. Studies have also shown that most 
companies do not recover from a major catastrophe that involves loss of company 
data. Here’s something else to consider if you think that you don’t need a disaster 
recovery plan for your business: disasters can also take the form of office fires or 
terrorist attacks, not just storms, earthquakes, floods and tornados. If an electrical 
problem caused a fire in your building, the parts that weren’t burned beyond recovery 
would probably be destroyed by the firemen’s efforts. Another common disaster is 
water damage caused by ruptured water pipes.  

     If Katrina has you re-thinking your own disaster recovery plan or wondering what 
you would do in the same situation, you should take action and start protecting 
yourself now. The following tips will help get you started in the right direction.  

Disaster Recovery Questions You Need To Answer  

     Most business owners shy away from creating a disaster recovery plan because 
they don’t know where to start, or because they think it will cost them a lot of time 
and money. For large financial institutions or companies maintaining mission critical 
data or software, this may be true; however, most small and mid-size businesses only 
need to take a few precautionary steps to ensure their businesses will continue 
running in the event of a natural disaster. First, ask yourself the following questions...  

1. Do you back up your company’s data daily?  
2. Do you keep a copy of your back up off site?  
3. Would you have access to your data remotely if you couldn't get to the office?  
4. Do you know how long it will take the IT department to retrieve a server back 

up? In many cases it takes days and often weeks; what would you do during 
that period of time?  

5. Do you regularly test your back up system to make sure it is a good copy and 
not corrupted?  

6. Do you store critical program passwords in a secure place that company officers 
can access if you are unavailable?  

7. Do you require several data entry stations to be running to keep up with your 
orders?  

8. Do you have a UPS (uninterruptible power supply) device in place to keep your 
network and other critical data operations running during a power outage? 

     These are just a few of the questions you need to answer. Obviously, other issues 
like insurance coverage and operational plans should also be integral elements of your 
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plan.  

Our FREE Disaster Recovery Plan Helps You Prepare For Catastrophes and 
Aides Hurricane Victims  

     In an effort to help our clients and the victims of hurricane Katrina, we are giving 
away free disaster recovery plan audits to any company in the Triangle area that 
donates money to a hurricane Katrina relief effort.  

     All you have to do is contact our office and show that you’ve donated $500 or more 
to a charity benefiting the victims of hurricane Katrina and we’ll audit your disaster 
recovery plan for free. Our company has already donated a considerable amount to 
the victims of hurricane Katrina and we hope to encourage others to do the same.  

     To be clear, we are not collecting money or selling any services; all you have to do 
is show us proof that you directly donated $500 or more to one of the many relief 
efforts for this recent disaster and we’ll give this service to you for free.  

     In doing so, we are hoping to not only help our clients and friends protect 
themselves from these types of disasters, but also encourage charitable donations. For 
more information, please contact our office at 369-7800 and speak to Joy, or e-mail 
us at service@pcmedevac.com  

 

Laptops are becoming a hot ticket item for thieves looking for an 
easy hit. When your laptop gets stolen, you lose a lot more than 
your computer and the cost of purchasing a replacement; you lose 
your documents, photos, e-mails, and database files. That is why it 
makes sense to take these simple steps to protect it.  

1. Don’t let it out of your sight. Wi-Fi hotspots like coffee shops can be distracting 
and are prime hangouts for laptop thieves. Don’t leave it on a table to get a 
refill, and don’t put it on the floor behind your chair.  

2. Don’t leave it on the seat of your car. Hide it under the seat or in the trunk or 
you could end up with a stolen laptop AND a broken car window.  

3. Don’t leave it in your hotel room. If it doesn’t fit in the hotel room’s safe, take it 
with you or ask hotel management to lock it up.  

4. Don’t advertise your laptop by keeping it in a computer bag. Instead, carry it in 
a briefcase, backpack, or large handbag.  

5. Carve your name into the plastic shell.. This will make it less attractive for 
resale and may deter thieves.  

6. Write your laptop’s serial number down and store it safely. It will help the police 
recover your laptop if it is stolen.  

7. Get a laptop alarm. One alarm, TrackIT, offers a portable, two-piece anti-theft 
system that uses a keychain and a miniature receiver with a sonic alarm. 
TrackIT's siren will sound when separated more than 40 feet (12 meters) from 
the transmitter on your keychain. This proximity alarm will protect against 
security check-in theft, distraction theft, and ordinary carelessness.  

8. Get a laptop cable lock. For around $50, you can purchase a cable and lock that 
will anchor your laptop to a heavy desk or piece of furniture and prevent it from 
being stolen by grab-and-run thieves when it is our of your sight.  

9. Get a tracking device installed. Computrace or CyberAngel can be purchased for 

10 Easy Ways To Protect Your Laptop From Being Stolen
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about $60 a year and will track your laptop’s location using a stealthy piece of 
tracking software if it is stolen. Many even offer a guarantee.  

10. Encrypt your files. A start up password will not protect someone from accessing 
your data since many thieves know how to bypass it. To protect your personal 
information from identity theft, use a program like BestCrypt or PC Encrypt to 
secure your personal information. 

And finally, don’t forget to back up your files and keep a copy of the backup in a 
separate location away from your laptop. Having a back up disk in your 
computer bag is no good if it gets stolen with your laptop.  

 

Tell me 10 things about your favorite pet or answer these 20 questions 
to discover your personality type. You might think this kind of e-mail or 
web form is a fun way to learn about yourself or communicate with 
friends, but beware! Spammers and hackers often use these forms to 
solicit personal information, steal your e-mail address, and spread 
viruses.  

Part of the problem is that people forward these surveys including their friends’ e-
mail addresses in the text of the email. This allows hackers and spammers to steal 
your e-mail address and the e-mail addresses of your friends to spread viruses or 
simply annoy you with endless spam. Best bet: Don't fill out surveys on a web site or 
an e-mail unless it’s with a reputable company for a legitimate reason and never 
forward them to others.  

 

 

This month we'd like to recognize a previous Client of the Month. Errico's Ristorante, 
our favorite family owned restaurant, is holding a raffle to raise money to aid those 
ravaged by recent hurricanes. Each month, Greg Lewis (with some volunteer chefs in 
training) hold a wine tasting dinner. This month the event will be 23 October and will 
include a raffle to raise funds to be donated to the American Red Cross. All proceeds 
from the wine tasting as well as the raffle will be donated. How can you help? You 
can attend the wine tasting dinner, you can donate items or services for the raffle or 
you can purchase a raffle ticket. Click on the link below to check out the great items 
already donated for the raffle. Question, contact Greg Lewis or call 481-0883.  

More information about the Raffle  

We love getting referrals from our loyal clients, and we’re not 
afraid to show it! Refer a new client to us during October, and we’ll 
give you a 512 mb USB thumb drive and your referral a FREE 

Beware of “Fun” Web Surveys!

Meet PC MedEvac's Client of the Month

Refer A New Client To Us In October ........
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SECURITY AUDIT.  

Everybody Wins! You get a cool new thumb drive and the person you refer gets the 
peace of mind with the security audit (they also get introduced to an honest, reliable 
technician who is dedicated to solving their computer problems). Just tell your 
friends to mention your name when they call so we can reward your loyalty and 
make sure they get their FREE audit.  

 

PC MedEvac has recently formed a collaboration with Technology 
Business Partnership. What this means for you is access to additional 
services. One of those services is one-on-one and group training.  

Chief trainer, Tricia Santos, provides the training you need, when you 
need it. Her basic philosophy is:  

"If you're going to do something once, let someone else do it. If you need to do it 
repeatedly, learn to do it yourself."  

Here's some "Tips and Tricks" from Tricia:  

Microsoft Word Tips & Tricks Since just about everyone uses Word (even those on 
the Mac), here are a few of my favorite Word tips and tricks to help you work 
smarter, not harder. Most of these work on both the Windows and Mac versions.  

First, no set of Word tips would be complete from me without a mention of tabs. 
So, set tabs! They take less than 10 minutes to learn and will save you hours and 
hours of formatting frustrations. Contact me if you want help with this.  

Have Office XP or 2003? Now, if you want to highlight various paragraphs 
throughout your Word document (that aren’t together, called non- contiguous), you 
can hold down the Control (Ctrl) key while highlighting each paragraph (or any 
passage of text).  

Take control of the Paste feature. When I copy and paste text into a Word 
document from another source (another document, a web page, etc.), the formatting 
is all wrong. Fixing this is simple. After you paste you should get a little drop-down 
menu appear at the end of what you pasted. If you click on it, you’ll see several 
choices. The default is to keep the original formatting. Instead, you can choose to 
match the destination formatting or keep text only (this will strip out any graphics).  

You can put the date, time, author, subject, and other document information into 
headers and footers. Click on View, Header and Footer. In the toolbar there are 
different icons for page numbering, date and time, etc., and there is a button for 
Insert AutoText. That will list other document information you can insert.  

If you’re like me, you occasionally add a word to your dictionary by mistake when 
you’re spell checking a Word document. To remove it, click on Tools, Options, then 
the Spelling & Grammar tab. Click on the Custom Dictionaries button, then Modify 
and delete any words that don’t belong there. The good news is, the other Office 
applications (PowerPoint, etc.) use the same dictionary. Now, while you’re at it, you 
may want to explore some of the other options available.  

Sometimes you have a document that is just a little more than a page. If you want 
it to be on one page, instead of making the changes yourself, you can have Word 
shrink it for you. Click on the File menu, then Print Preview. In the preview screen, 
there is an icon called “Shrink to Fit” that will do that.  

Collaboration Allows PC MedEvac to Extend Its Services
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Have you accidentally figured out what the Insert key does? It switches you to 
Overstrike mode where instead of inserting text it overwrites it. I can’t think of a 
time when I wanted that to happen (and find it most annoying!). So, I’ve changed it 
so that key actually inserts, or pastes, whatever is in the clipboard. To do that, click 
on the Tools menu, choose Options, then the Edit Tab. Put a checkmark next to "Use 
the INS key for paste" and press OK.  

If you want to save several documents at once, hold down the Shift key when you 
click on the File menu. You’ll get an option to Save All.  

If you open Word and everything is out of whack (toolbars missing, etc.), the 
likely culprit is a corrupted normal template. The simplest thing to do is get rid of it. 
Close Word and use the Find/Search feature in Windows to locate normal.dot. You 
can either delete it or rename it to something like normalold.dot. When you reopen 
Word it will create a new template with default settings.  

Do you have a few Word files you use all the time? If so, you can add them to 
their own drop- down menu and open them with 2 clicks. To add the menu to your 
toolbar, click on the View menu, Toolbars, then Customize. In the Customize dialog 
box, click on the Commands tab, then scroll down the list on the left until you find 
Built-in Menus and click on it. On the right side, scroll until you see Work. Click on it 
and drag it up to where you want it on your toolbar. When you’re done, click on the 
Close button. 

If you're interested in training, either one-on-one, or for your employees as a group, 
call Technical Business Partnership at 369-1719 or email Tricia directly.  

 

 

Did You Know PC MedEvac does.......
You know what types of services we provide for you or your company, but did you 
know that PC MedEvac also provides these other services? 

General Network Repair and Troubleshooting  
Network Design and Implementation  
Disaster Recovery  
Virus Protection and Removal  
Network Security  
Remote Monitoring and Solutions  
Wireless Networking  
Thin Client Computing  
Storage and Backup Solutions  
and many, many more, just ASK!!!  

Create and Send Eye-Catching HTML Email Campaigns in 
Minutes!

Constant Contact®, Do-It-Yourself Email Marketing® is the 
leading web-based email marketing service used by over 
40,000 small businesses and associations. With Constant 
Contact, you can create email newsletters and 
announcements that get immediate and measurable results. 

1. 100+ professional HTML email templates  
2. Simple wizard - no technical skill required  
3. Easily build & manage your email lists 
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4. Real-time reporting - including who opened and clicked  
5. High email delivery rates 
6. FREE phone and email support 
7. Starting at just $15 per month  

Sign up Now for Your 60-day FREE Email Marketing Trial 
No risk, no obligation, No credit card required 

Constant Contact Free 60 Day Trial  

Quick Links...
More About PC MedEvac Interested in Growing Your 

Business With Referrals?

Try an Electronic Newsletter 
Service free for 60 days!

email: theresa@pcmedevac.com  
phone: 919.369.7800  
web: http://www.pcmedevac.com  

 

Free 
Computer 
Support

Put that checkbook away! We offer two free hours of computer support to 
all first-time business customers. If you have 5 or more PCs and need help 
troubleshooting a problem, eliminating spam or spyware, making your 
network more secure from viruses, or if you simply want a second opinion 
on a new project, give us a call. The first two hours are on us!  

Set up your appointment now....  
 

Forward email 
 

 
This email was sent to theresa@pcmedevac.com, by theresa@pcmedevac.com 
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